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1. Introduction 
 

1.1. À propos de Terabee 
 
Ce nouveau capteur de proximité est le plus léger et le plus compact de la gamme des                                 
capteurs TeraRanger Evo ! Il apporte à la fois performance, flexibilité et un excellent                           
rapport qualité/prix ! Optimisé pour la mesure de distances en intérieur, le Evo Mini offre                             
des capacités de mesure à partir de 3 cm et jusqu'à 3.3 m ! Changez facilement du mode "1                                     
pixel" aux modes multi-pixels pour répondre à vos besoins de mesure de distance.  
 

 
Figure 1. Capteur TeraRanger Evo Mini, vue de face 

 
Le Evo Mini est protégé de la poussière et résiste aux projections d'eau. Bénéficiez                           
également de codes d'exemples Arduino & Raspberry Pi, ainsi que de paquets ROS mis à                             
disposition pour que vos projets démarrent et soient opérationnels en un rien de temps ! 
 

 

1.2. Symboles 
 
Les symboles suivants sont régulièrement utilisé dans ce manuel d’utilisation: 
 

 
Ce symbole indique une recommandation spécifique afin d’utiliser le capteur dans                     
des conditions optimales. 
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1.3. Spécifications techniques 
 

Tableau 1 -Spécifications techniques du TeraRanger Evo Mini 
Code produit  TR-EVO-MINI-USB / TR-EVO-MINI-I2C 

Performance   

Technologie d’acquisition   Temps de vol (ToF) par mesure infrarouge  

Longueur d’onde de la source lumineuse  940 nm 

Environnement d’utilisation  Intérieur 

Répétabilité  < 5 mm 

Résolution de sortie de distance  1 mm 

Champ de vision  27° 

Zone de réception projetée  48 cm x 48 cm @ 1 m 

Modes d’utilisation  Modes d’acquisition (px) : 1px, 2px, 4px (2x2) 
Modes de mesure: courte portée, longue portée 

Portée   
 

Pour plus d’informations, référez-vous à la matrice de performance ci-dessous Précision 

Fréquence d’acquisition 

Données électriques       

Tension en fonctionnement  VDC   5V DC  +/-5% 

Intensité en fonctionnement (moyenne)  50mA 

Temps d’initialisation  < 1 s 

Interfaces       

Interfaces physiques  USB 2.0 Micro-B 
UART, +3.3V level, 115200,8,1, None 

 I2C, +3.3V level, 400 kHz 

Interfaces visuelles  2 x LEDs (montées sur la carte d’interface) 

Données mécaniques       

Dimensions  42 x 30 x 13 mm  (carte d’interface incluse) 

Poids  9 g (carte d’interface incluse) 

Températures en fonctionnement  -20°C à 75°C 

Matériau du boîtier   ABS 
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Montage  2 trous pour vis M2 

Type de connecteur  Carte d’interface USB: USB 2.0 Micro-B 
Carte d’interface I2C/UART: connecteur DF13-7p  

Carte d’interface Hub Evo pour utilisation avec TeraRanger Hub Evo 

Conformité       

Certifications  CE, RoHS 

 
 

1.3.1. Matrice de performances 

Tableau 2 - Matrice de performances pour les différents modes d’acquisition et de mesure 

Mode de 
mesure 

  Mode courte portée    Mode longue portée 

Mode 
d’acquisition 

  Mode 1px  Mode 2px  Mode 4px    Mode 1px  Mode 2px  Mode 4px 

Portée    0.03m à 
1.35m 

0.03m à 
1.35m 

0.03m à 
1.35m 

  0.03m à 3.3m  0.03m à 2.3m  0.03m à 1.65m 

Précision    +/-1.5cm  +/-1.5cm  +/- 2cm    +/- 2cm  +/-1.5cm   +/- 3cm 

Fréquence 
d’acquisition 

  Fixée à 40Hz  Fixée à 13Hz  Fixée à 6Hz    Fixée à 20Hz  Fixée à 8Hz  Fixée à 4Hz 

 
Les spécifications techniques ont été validées par des tests réalisés dans des conditions contrôlées (cible avec 80% de                                   
réflectivité diffuse, lumière fluorescente intérieure, température ambiante d’environ 25°C). Il est important de noter que les                               
performances du capteur peuvent être affectées par une vive lumière du soleil, par la réflectivité de la cible et d’autres                                       
paramètres extérieurs. 

 

1.3.2 Interfaces de communication 

Tableau 3 - Interfaces de communication pour les différents modes d’acquisition et de mesure 

Interface    Mode courte portée    Mode longue portée 

    Mode 1px  Mode 2px  Mode 4px    Mode 1px  Mode 2px  Mode 4px 

USB    Yes  Yes  Yes    Yes  Yes  Yes 

UART*    Yes  Yes  Yes    Yes  Yes  Yes 

I2C*    Yes        Yes     

Hub Evo            Yes     

 
*Note: Les communications UART et I2C sont supportées par la même carte d’interface. 
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1.4. Introduction aux modes d’acquisition 
Le TeraRanger Evo Mini offre 6 modes d’utilisation différents répartis entre 3 modes                         
d’acquisition et 2 modes de mesure. Pour plus de détails concernant les changements de                           
mode, référez-vous à la Partie 5 de ce manuel d’utilisation. 
 
Profitez de 3 modes d’acquisition distincts proposant de lire une mesure unique (Mode                         
1px), 2 distances en parallèle (Mode 2px) et 4 distances en même temps (2x2) (Mode 4px).                               
Le tableau 4, ci-dessous, offre une représentation visuelle pour chacun de ces modes                         
d’acquisition. 
 

Tableau 4 - Introduction aux modes d’acquisition du TeraRanger Evo Mini  

Mode 1px  Mode 2px  Mode 4px (2x2) 

 
Le capteur renvoie une seule 

distance. 
 
 
 

 
Le capteur renvoie 2 

distances. 
 
 
 

 
Le capteur renvoie 4 

distances, disposées sur une 
matrice de 2x2. 
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2. Intégration mécanique 
 
2.1. Une conception modulable (clip-in, clip-off) 

 
La conception mécanique du module de détection (noir) permet d’assembler facilement la                       
carte d’interface (jaune), simplement en clipsant les 2 pièces entre elles. Lors de cette                           
opération, assurez-vous que les deux pièces se touchent conjointement.  
 

   

Figure 2 - Conception modulable du TeraRanger Evo Mini  
 

2.2. Conception mécanique et montage 
 
Le capteur TeraRanger Evo Mini est composé d’un boîtier en plastique ABS (pour le module                             
de détection et la carte d’interface). Le capteur peut être monté à l’aide de 2 vis M2, grâce                                   
aux 2 trous prévus à cet effet dans le boîtier de la carte d’interface. La Figure 3 donne accès                                     
aux dimensions extérieures du TeraRanger Evo Mini. 
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Figure 3 - Dimensions extérieurs du TeraRanger Evo Mini (carte d’interface USB) 

 
Les dimensions extérieurs du capteurs restent inchangées quand la carte d’interface                     
I2C/UART est utilisée. La seule légère variation vient de la taille du connecteur de la carte                               
d’interface qui n’est pas la même. 
 
Les deux cartes d’interface USB et I2C/UART contiennent 2 trous pour monter le capteur                           
avec des vis M2. Voici, ci-dessous, deux propositions pour monter le TeraRanger Evo Mini: 
 

1. Montage par l’arrière en utilisant 2 vis M2 
2. Montage pas l’avant en utilisant l’épaulement de 2 mm sur la face avant du capteur 

 
La Figure 4 illustre les deux montages décrits ci-dessus. La première solution permet une                           
fixation facile et une rapide évaluation du capteur. La seconde offre un montage plus                           
discret du capteur et permet une intégration optimale et personnalisée à vos projets, en                           
installation le capteur derrière une surface (idéalement de 2mm). 
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  Figure 4. Montage par l’arrière (à gauche); Montage par l’avant (à droite) 
 

2.3. Précautions de montage 
   
Avant de choisir l’endroit de montage de votre TeraRanger Evo Mini, il est conseillé de                             
suivre les quelques recommandations suivantes: 
 

● Les sources de chaleurs ou les champs électromagnétiques puissants peuvent                   
affecter les performances du capteur 

● Ne rien monter en face du capteur ou dans un cône de +/-35° autour de l’axe                               
optique du capteur 

● Eviter la présence d’objets à grande réflectivité, dans un cône de +/-45° autour de                           
l’axe optique du capteur, et ce sur le premier mètre par rapport au capteur 

● Il est préférable de ne pas avoir d’autres sources d’ondes continues ou de lumière                           
infrarouge proche du capteur 

● La poussière, la saleté et la condensation peuvent affecter les performances du                       
capteur 

● Il n’est pas conseillé d’ajouter une vitre supplémentaire au devant du capteur 
 

 

Pendant l’assemblage et l’intégration, veillez à suivre les précautions ESD                   
standards. Toutes les surfaces optiques (face avant du capteur) doivent rester                     
propres et éviter tout contact avec des produits chimiques. 
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3. Utilisation de la carte d’interface USB 

3.1. Indications des LEDs 

3.1.1. Opération standard 

 
Trois LEDs sont présentes sur la carte d’interface USB, et sont visibles à travers la face                               
arrière du boîtier plastique jaune. 
 

Tableau 5 - Indications des LEDs de la carte d’interface USB 

LED   Description 

PWR (ORANGE)  La LED d’alimentation (PWR) est allumée dès que le capteur est 
alimenté. 

ROUGE  La LED rouge flashe brièvement au démarrage pour indiquer la                   
bonne initialisation du capteur. Ensuite la LED reste éteinte. 

VERTE  La LED verte clignote 8 fois dès qu’elle est alimentée. 
Ensuite, la LED clignote toutes les 5 secondes en fonctionnement                   
normal du capteur 

 

 
Le nombre de LEDs et leur signification varie entre la carte d’interface USB et la                             
carte d’interface I2C/UART. 

 

3.1.2. Messages d’erreurs et dépannage 

 
Tableau 6 - Messages d’erreurs de la carte d’interface USB 

LED  Séquence  Signification  Actions correctives 

ROUGE  Clignotement 
continu 

Le capteur a détecté une         
erreur et a arrêté de         
fonctionner 

Vérifier que le capteur est bien           
connecté à la carte d’interface.         
Redémarrer le capteur. 

ROUGE / 
VERTE  

Les deux LEDs 
clignotent en 
continu  

Le capteur a détecté une         
erreur pendant la phase       
d’initialisation du capteur 

Vérifier le message d’erreur 
renvoyé par la carte 
d’interface USB pour plus 
d’informations. 
Vérifier que le capteur est bien           
connecté à la carte d’interface,         
redémarrer le capteur. 
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ROUGE / 
VERTE 

Clignotement 
alterné (rouge / 
vert / rouge / 
vert / etc) with 
1 s intervals 

Le capteur ne s’est pas         
initialisé parce que la       
dernière mise à jour du         
micrologiciel a été     
interrompue.  
 
Le capteur ne peut pas être           
utilisé.  

Mettre à jour le micrologiciel,         
en connectant le capteur à         
l’interface graphique (GUI). Ne       
pas cliquer sur Connect.       
Maintenir appuyée la touche       
“MAJ” de votre clavier, et         
cliquer sur File > Upgrade         
Firmware. La GUI va entrer         
dans l’interface de mise à jour.           
Pour plus d’informations,     
référez-vous à la Partie 3.2.3 

 
 

3.2. Interface graphique : GUI (version 1.0.31) 
Une interface graphique (GUI) dédiée est disponible gratuitement en ligne, offrant un                       
moyen simple de visualiser les données de distance du capteur avec Windows. Cet outil est                             
pratique lors de présentations, pour tester ou pour découvrir les paramètres principaux du                         
capteur. L’interface graphique permet également de facilement mettre à jour le capteur                       
avec la dernière version du micrologiciel. 
 
Assurez-vous d’utiliser la GUI version 1.0.3 ou + (la version actuelle permet une utilisation                           
uniquement avec le mode d’acquisition 1px). La GUI TeraRanger Evo Mini est disponible au                           
téléchargement sous la section “Downloads” de la page produit Evo Mini, ou en accédant                           
au site internet via le lien suivant: 
 
https://www.terabee.com/wp-content/uploads/2019/04/TeraRangerEvoInstaller_v1_0_3.exe 
 

 

Si le TeraRanger Evo Mini est utilisé avec la GUI en mode 2px ou en mode 4px, ou                                   
en sortie d’acquisition texte, le capteur ne renverra pas de distances. Réferez-vous                       
à la Partie 5 pour plus d’informations sur les modes d’acquisition et les sorties                           
d’acquisition. 
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3.2.1.Prérequis 

 
Pour utiliser le capteur avec Windows 7 et Windows 8, veuillez télécharger le driver pour                             
port COM virtuel en cliquant sur le lien suivant: 
http://www.st.com/en/development-tools/stsw-stm32102.html; et suivre les indications         
présentées dans le fichier “ReadMe”. Une fois l’installation terminée, débranchez l’interface                     
pendant plusieurs secondes, puis rebranchez. Le driver pour port COM virtuel est                       
maintenant disponible sur votre ordinateur. 
 

 
Sous Windows 10, le driver est déjà intégré à l’architecture du système 

 

3.2.2.Opérations normales avec la GUI, supportant le mode 1px 

 
Assurez-vous que le TeraRanger Evo Mini est connecté à un port USB de votre ordinateur.                             
Via l’interface graphique, sélectionnez File > Connect. Une distance (en millimètres)                     
s’affiche automatiquement et le statut est passé à ‘Connected’. 
 

 
Figure 5 - TeraRanger Evo Mini GUI pour mode 1px 
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A chaque fois que le TeraRanger Evo Mini est démarré, le capteur utilise ses paramètres                             
par défaut (mode 1px, sortie d’acquisition binaire). Pour changer la configuration du                       
capteur, consultez la Partie 5 de ce manuel. 
 

 

Dans les cas où la GUI ne renvoie pas de distances, malgré la bonne connection                             
physique à l’ordinateur, débrancher et rebrancher le capteur à l’ordinateur. Si le                       
problème persiste, n’hésitez pas à nous contacter à l’adresse                 
support@terabee.com pour obtenir des informations complémentaires.  

 

3.2.3.Mise à jour du micrologiciel 

La section suivante décrit étape par étape, le processus de mise à jour du micrologiciel de                               
votre capteur. Cette opération est utile lorsqu’un nouveau micrologiciel est disponible                     
(auquel cas vous serez informé par Terabee) ou lorsqu’il est nécessaire de mettre à jour le                               
capteur. 
 

 
La version du micrologiciel de votre TeraRanger Evo Mini est consultable en                       
sélectionnant Help > About dans l’interface graphique. 

 
Notez que la mise à jour du micrologiciel n’est supportée que sur Windows 7, 8 et 10. Pour                                   
effectuer la mise à jour, suivez dans l’ordre et jusqu’au bout les étapes décrites dans le                               
tableau 7. Une interruption du processus de mise à jour peut créer une erreur permanente                             
sur votre capteur. 
 

 
Une mauvaise exécution de la mise à jour peut mener à un effacement complet du                             
micrologiciel du capteur. 

 
Tableau 7 - Instructions pour la mise à jour du micrologiciel 

Étape  Action  Description 

1  Télécharger la 
GUI 

Téléchargez la dernière version de la TeraRanger Evo 
GUI. La GUI est disponible sur la page produit du 
TeraRanger Evo Mini. Référez-vous à la partie 3.2 pour 
plus de détails. 

2  Installer GUI  Installer la version téléchargée de la TeraRanger Evo GUI. 
Référez-vous à la partie 3.2 pour plus de détails. 

3  Télécharger le 
micrologiciel 

Téléchargez la dernière version du micrologiciel Evo Mini, 
disponible sur la page produit du TeraRanger Evo Mini, 
ou en contactant notre équipe support technique. 

4  Démarrer la 
procédure de 

Dans la GUI, sélectionnez File > Connect puis File > 
Upgrade Firmware.  
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mise  à jour  Cliquez  ‘Yes’ dans la boîte de dialogue pour confirmer le 
démarrage de la procédure de mise à jour 

5  Mettre à jour 
le micrologiciel 

Une nouvelle boîte de dialogue présente la marche à                 
suivre pour sélectionner le micrologiciel et démarrer la               
mise à jour. Lisez-en bien les instructions avant de                 
continuer. 
Cliquez sur ‘Select File’ et sélectionnez le nouveau               
micrologiciel que vous avez téléchargé.  
Cliquez sur ‘Upgrade’ et attendez jusqu’à la fin de                 
l’opération.  

6  Fermer la 
procédure de 
mise à jour 

Une fois la mise à jour terminée, la boîte de dialogue                     
affiche ‘Firmware upgraded’ dans le coin en bas à                 
gauche. Fermez la boîte de dialogue. Le capteur est                 
maintenant prêt à être utilisé.  
Note: la boîte de dialogue se ferme automatiquement au                 
bout de 5 secondes après la fin du processus. 

 

 

Une fois l’étape 4 commencée, il est impératif de suivre toutes les étapes jusqu’à                           
l’étape 6. Si la procédure est interrompue entre ces étapes, le capteur entrera en                           
mode erreur. Référez-vous à la partie 3.1.2 pour plus d’informations. 

3.3. Connecter le TeraRanger Evo Mini à un ordinateur 

3.3.1 Windows OS 

Sous Windows, il est aussi possible d’utiliser n’importe quel émulateur de terminal pour                         
afficher les données. Terabee a l’habitude de recommander et de travailler avec le logiciel                           
HTerm. Cliquez sur le lien suivant pour télécharger le logiciel                   
(http://www.der-hammer.info/terminal/), et sélectionnez la version 0.8.2 du logiciel. 

Extraire le fichier zip vers le dossier de votre choix, ouvrez- le et effectuez un double-clique                               
sur le fichier “HTerm.exe”. Connectez le TeraRanger Evo Mini à l’ordinateur et sélectionnez                         
le port USB correspondant (cliquez sur le bouton “R” pour rafraîchir la liste des ports).                             
Pensez à bien configurer le logiciel avec les paramètres suivants:  

Baud rate : 115200 bit/s 
Data bits : 8 
Parity bit : None 
Stop bit  : 1 
 
Pour faciliter la lecture des données, sélectionnez l’option “LF” dans le menu déroulant                         
“Newline at”. Référez-vous à la Figure 6 pour visualiser la fenêtre. 
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Figure 6 - HTerm: Paramètres du TeraRanger Evo Mini 

Une fois le port USB sélectionné et les paramètres renseignés, cliquez le bouton                         
“Connect”. Les données de distance apparaissent maintenant dans la fenêtre “Received                     
data” (Figure 7). L’émulateur HTerm permet d’acquérir les données dans tous les modes                         
d’acquisition du capteur, à savoir le mode 1px, le mode 2px et le mode 4px. 

 

 

Figure 7 - Stream de données avec HTerm: 
 Mode 1px (à gauche); mode 4px (à droite) 

 
Pour communiquer avec l’émulateur de terminal, il est nécessaire d’envoyer une                     
commande en hexadécimal, grâce au champ “Type”. Assurez-vous que la case “Hex” est                         
bien cochée, et que le champ “Type” est paramétré avec l’option “HEX”. La Figure 7 donne                               
pour exemples, les commandes permettant d’afficher les données en sortie texte (à                       
gauche) et de passer le capteur en mode 4px (à droite). 

3.3.2 Mac Os 

Sous Mac OS, il est aussi possible d’utiliser un émulateur de terminal pour afficher les                             
données du capteur. Terabee a l’habitude de recommander et detravailler avec le logiciel                         
Coolterm. Cliquez sur le lien suivant pour télécharger le logiciel                   
(https://freeware.the-meiers.org/).  

Effectuez un double clique sur le fichier “CoolTermMac.dmg”, puis sur l’icône Coolterm.                       
Connectez le TeraRanger Evo Mini à l’ordinateur et cliquez sur le bouton “Options”.                         
Sélectionnez le port USB correspondant (si nécessaire, cliquez sur le bouton “Re-Scan                       
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Serial Ports” pour rafraîchir la liste de ports), puis configurez le logiciel avec les                           
paramètres suivants:  

Baud rate : 115200 bit/s 
Data bits : 8 
Parity bit : None 
Stop bit  : 1 

 

Figure 8 - Coolterm: Paramètres du TeraRanger Evo Mini 

Une fois le port USB sélectionné et les paramètres renseignés, cliquez sur le bouton                           
“Connect”. Les données apparaissent maintenant (Figure 9). L’émulateur Coolterm permet                   
d’acquérir les données dans tous les modes d’acquisition du capteur, à savoir le mode 1px,                             
le mode 2px et le mode 4px. 

 

Figure 9 - Stream de données avec Coolterm: 
 mode 1px (à gauche); mode 2px (à droite) 
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Pour communiquer avec l’émulateur de terminal, cliquez sur Connection > Send String.                       
Une fenêtre s’ouvre, permettant d’envoyer des commandes au Evo Mini. Assurez-vous que                       
la case “Hex” est sélectionnée, car la commande doit être envoyée en hexadécimal. Entrez                           
votre commande et cliquez le bouton “Send”. La Figure 9 donne pour exemples, les                           
commandes permettant d’afficher les données en sortie texte (à gauche) et de passer le                           
capteur en mode 2px (à droite). 
 

4. Utilisation de la carte d’interface I2C/UART 
Le TeraRanger Evo Mini peut être contrôlé via une interface UART ou une interface I2C en 
utilisant la carte d’interface I2C/UART. 

 

Figure 10 - Carte d’interface I2C/UART (vue de face) 

4.1. I2C/UART pinout 
La carte d’interface I2C/UART utilise un connecteur à 9 pins Hirose DF13 pour interfacer                           
avec le système parent. Le connecteur femelle correspondant est le Hirose DF13-9s-1.25C                       
avec contacts à sertir DF13-2630SCF (tin) ou DF13-2630SCFA (gold). Prenez soin de ne pas                           
tirer violemment sur le connecteur (pendant l’installation ou après l’intégration) pour ne                       
pas arracher les contacts. Pour assurer une connection fiable, Terabee recommande de                       
suivre les recommandations de la fiche technique de Hirose (disponible ici:                     
https://www.hirose.com/product/en/products/DF13). 

 
Tableau 8 - Description des contacts (Suivant la fiche technique DF13) 

Piste  Désignation  Description 

1  Tx  Sortie de transmission UART. Niveau logique 3.3V 

2  Rx  Entrée de réception UART. Niveau logique 3.3V 

3  GND  Masse de l’alimentation et de l’interface 

4 SDA Ligne data du bus I2C. Niveau logique 3.3V 

5 SCL Ligne clock du bus I2C. Niveau logique 3.3V 

6  rfu  RÉSERVÉ POUR USAGE FUTURE 
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7  5V  Alimentation +5V 

8  GND  Masse de l’alimentation et de l’interface 

9  rfu  RÉSERVÉ POUR USAGE FUTURE 

4.2. Indications des LEDs 

4.2.1. Opération standard 

Trois LEDs sont présentes sur la carte d’interface I2C/UART, et sont visibles à travers la face                               
arrière du boîtier plastique jaune. 
 

Tableau 9 - Indications des LEDs de la carte d’interface I2C/UART 

LED  Description 

PWR (orange)  La LED d’alimentation indique que le capteur est alimenté avec 
un signal +5V. Elle reste allumée en continu. 

Rx (rouge)  
Tx (verte) 

LEDs indiquants la transmission et la réception de signaux 
I2C/UART. 
Clignote à chaque fois qu’une données est envoyées ou reçue. 

 

4.2.2. Messages d’erreurs et dépannage 

 
Tableau 10 - Messages d’erreurs de la carte d’interface I2C/UART 

Indications 
des LEDs 

Séquence  Signification  Actions correctives 

ROUGE  Clignotement 
continu 

Le capteur a détecté une 
erreur et a arrêté de 
fonctionner 

Vérifier que le capteur est bien 
connecté à la carte d’interface. 
Redémarrer le capteur. 

ROUGE / 
VERTE  

Clignotement 
continu  

Le capteur a détecté une 
erreur pendant la phase 
d’initialisation du capteur 

Vérifier le message d’erreur 
renvoyé par la carte 
d’interface I2C/UART pour plus 
d’informations. 
Vérifier que le capteur est bien 
connecté à la carte d’interface, 
redémarrer le capteur. 

ROUGE / 
VERTE 

Clignotement 
alternatif 
(rouge / vert / 
rouge /vert) à 
intervals d’1s 

Le capteur ne s’est pas 
initialisé parce que la 
dernière mise à jour du 
micrologiciel a été 
interrompue.  
 

Mettre à jour le micrologiciel. 
Pour plus d’informations, 
référez-vous à la Partie 3.2.3 
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Le capteur ne peut pas être           
utilisé.  

 

4.3. Caractéristiques électriques 
Tableau 11 - Consommation électrique du TeraRanger Evo Mini 

Paramètre  Minimum  Maximum  Moyenne 

Alimentation 
Tension (V) 

Intensité (mA) 

 
4.5V 

25mA 

 
5.5V 

75mA 

 
5V 

50mA 

Niveaux logiques 
(+3V3)  
LOW 
HIGH 

 
 
- 

2.3 

 
 

1 
- 

 
 
- 
- 

 
 

5. Utilisation standard en USB/UART 

5.1. Liste des commandes pour USB/UART  
 

Tableau 12 - Liste des commandes du TeraRanger Evo Mini 

Commande 
(HEX) 

  Type de commande  Nom de la commande 

00 11 01 45  SORTIE D’ACQUISITION   TEXTE 

00 11 02 4C  SORTIE D’ACQUISITION   BINAIRE 

00 21 01 BC MODE D’ACQUISITION   MODE 1PX 

00 21 03 B2 MODE D’ACQUISITION  MODE 2PX 

00 21 02 B5 MODE D’ACQUISITION   MODE 4PX 

00 61 01 E7 MODE DE MESURE  MODE COURTE PORTÉE 

00 61 03 E9 MODE DE MESURE  MODE LONGUE PORTÉE 

 
Référez-vous à la Partie 3.3 pour avoir plus d’informations concernant l’envoi d’une                       
commande au TeraRanger Evo Mini avec un ordinateur. 
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Chaque commande doit être envoyée d’un seul tenant, et non octet par octet. 

 

 
Il est conseillé de garder un intervalle de temps de quelques microsecondes entre 
deux messages pour assurer la bonne prise en compte de la commande. 

 

5.2. Sortie d’acquisition: TEXTE et BINAIRE 

5.2.1. Sortie TEXTE 

Cette sortie permet à l’utilisateur d’acquérir des données naturellement déchiffrables. En                     
utilisant le capteur en mode 1px sous HTerm, les distances mesurées sont retournées en                           
millimètres, sous la forme d’un message de 3 à 5 octets: xxxx\n (le nombre d’octets                             
dépend du nombre de chiffres de la distance retournée) 
 
Distance mesurée en mm : xxxx  
Caractère de renvoi à la ligne : \n (10 décimal / 0x0A hex) 
 

 
Figure 11 - Structure du message en sortie texte pour le mode d’acquisition 1px 

 

 
Référez-vous à la Partie 5.5 pour plus de détails concernant les cas d’erreurs qui                           
renvoient des données non numériques. 

 

 
Note: les mesures ne contiennent pas de zéros inutiles. 

 
Quand le capteur est utilisé en mode 2px ou en mode 4px, les distances mesurées sont                               
retournées en millimètres et séparées les unes des autres par une virgule. Le caractère de                             
renvoi à la ligne n’est envoyé qu’à la fin de la séquence de mesures. Par exemple, le mode                                   
4px donne un message de 9 à 17 octets: xxxx, xxxx, xxxx, xxxx\n (le nombre d’octets                               
dépend du nombre de chiffres de chaque distance retournée) 
 

 
Figure 12 - Structure du message en sortie texte pour le mode d’acquisition 4px 
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La structure du message est la même pour le mode 2px que pour le mode 4px, à                                 
l’exception près que le message ne contient que 2 mesures, résultant donc un                         
message de 5 à 9 octets. 

 

5.2.2 Sortie BINAIRE (par défaut) 

Cette sortie permet à l’utilisateur d’acquérir des données en format binaire, sous la forme                           
d’un message de 4 octets: TXXCRC8. La sortie d’acquisition binaire est la sortie par défaut                             
du capteur. 
 
En mode 1px, l’empreinte est calculée à partir des 3 premiers octets du message (octet du                               
header et octets de la mesure). 
 
Header (1 octet)        : T (84 décimal / 0x54 hex) 
Distance mesurée en mm (2 octets)  : XX  
Empreinte (1 octet)        : CRC8 
 

 
Figure 13 - Structure du message en sortie binaire pour le mode d’acquisition 1px 

 

 

Le TeraRanger Evo Mini renvoie T01CRC (1er octet de mesure mis à 0 et le second                               
à 1) comme message d’erreur si le capteur ne peut pas mesurer de distance. 
Référez-vous à la Partie 5.5 pour plus d’informations sur les messages d’erreur. 

 
Quand le capteur est utilisé en mode 2px ou en mode 4px, les distances mesurées (2                               
octets chacunes) sont retournées en millimètres les une après les autres. L’empreinte est                         
calculée uniquement à la fin de la séquence de mesures, à partir des octets précédents du                               
message. Par exemple, le mode 4px donne un message de 10 octets: TXXXXXXXXCRC8 
 

 
Figure 14 - Structure du message en sortie binaire pour le mode d’acquisition 4px 

 

 

La structure du message est la même pour le mode 2px que pour le mode 4px, à                                 
l’exception près que le message ne contient que 2 mesures, résultant donc un                         
message de 6 octets. 
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5.3. Modes d’acquisition: 1px, 2px and 4px 

5.3.1 Mode 1px (par défaut) 

Utilisé dans ce mode d’acquisition, le TeraRanger Evo Mini retourne une seule mesure de                           
distance en millimètres, calculée sur l’intégralité du champ de vision du capteur (27°). C’est                           
le mode d’acquisition par défaut du capteur. 

5.3.2. Mode 2px 

Utilisé dans ce mode d’acquisition, le TeraRanger Evo Mini retourne deux mesures de                         
distance en millimètres, calculée sur un champ de vision de 20° (dans la diagonale). La                             
figure 15 montre la disposition des pixels et dans quel ordre les mesures sont renvoyées. 

5.3.3. Mode 4px 

Utilisé dans ce mode d’acquisition, le TeraRanger Evo Mini retourne quatre mesures de                         
distance en millimètres. Chaque mesure (pixel) est calculée sur un champ de vision de                           
13.5°, ce qui représente une surface de 24 cm x 24 cm à 1 m. La figure 15 montre la                                       
disposition des pixels et dans quel ordre les mesures sont renvoyées. 
 

 
Figure 15 - Mode 1px (à gauche), Mode 2px (au centre), Mode 4px (à droite) 

 

 

La disposition des pixels sur la Figure 15 montre à la fois la position de chaque                               
pixel dans l’espace, et l’ordre dans lequel les mesures sont affichées (Pixel 1 = 1ère                             
mesure affichée, Pixel 2 = deuxième mesure affichée,...)  
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5.4. Modes de mesure: courte portée et longue portée 

5.4.1. Mode longue portée (par défaut) 

Utilisé en mode longue portée, le TeraRanger Evo Mini peut mesurer de 0.03m jusqu’à                           
3.3m. C’est le mode de mesure par défaut du TeraRanger Evo Mini. 

5.4.2. Mode courte portée 

En mode courte portée, le TeraRanger Evo Mini mesure plus fréquemment and de manière                           
plus précise. En contrepartie, la portée maximale du capteur est réduite à une distance de                             
1.35 m. Il est donc important de prendre que le mode courte portée n’est pas utilisable                               
pour des applications qui requièrent des mesures supérieures à 1.35 mètres. 
 

 

Quand le TeraRanger Evo Mini n’est plus alimenté, il se reconfigure                     
automatiquement dans ces modes par défaut, à savoir: sortie d’acquisition                   
binaire, mode d’acquisition 1px, et mode longue portée. 

 

5.5. Cas d’erreurs 
Tableau 13 - Cas d’erreurs du TeraRanger Evo Mini 

Cas d’erreurs  BINAIRE  TEXTE  

Détection en-dessous de la portée minimale  0X0000  -Inf\n 

Détection au-delà de la portée maximale  0XFFFF  +Inf\n 

Mesure invalide: 
- Lumière ambiante trop élevée 
- Surface cible trop réflective 

0x0001  -1\n 
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6. Utilisation standard en I2C 
 

 

L’acquisition de données avec le protocole de communication I2C grâce à la carte                         
d’interface I2C/UART), n’est possible qu’avec le mode d’acquisition 1px du capteur -                       
aussi bien en mode courte portée qu’en mode longue portée 

6.1. Information sur le protocole I2C 
Le protocol I2C supporte les paramètres de communication suivants: 

Fréquence: 400kHz 
Primary Address Length: 7-bit 
Primary Slave Address: 0x31 
Built-in pull-up resistors: 10 kOhms sur SDA et SCL (ne pas rajouter de résistances 
sur ces bus pour éviter les problèmes de transmission) 

 
Le TeraRanger Evo Mini fonctionne en continu, c’est-à-dire qu’une nouvelle mesure est                       
démarrée dès que la précédente est terminée. Les données affichées via le protocole I2C                           
sont toujours mises à jour à la fin de la mesure. Néanmoins, la mesure peut être lue à                                   
n’importe quel moment. 
 
Pour lire une distance, il faut envoyer une commande ‘Trigger Reading’ au capteur -                           
envoyer 0x62 (l’adresse 7-bit 0x31 suivie du bit d’écriture ‘0’), puis en lisant la mesure du                               
capteur en envoyant 0x63 (l’adress de base avec le bit de lecture ‘1’) suivi de trois octets                                 
d’opérations de lecture. Les deux premiers octets reçus forment un message de 16 bits                           
contenant la dernière mesure en mm, le troisième octet est l’empreinte CRC8. 
Pour plus de détails concernant les messages d’erreurs relatives au protocole de                       
communication I2C, référez-vous à la Partie 6.2. 

6.1.1. Protocole d’écriture 

Pour écrire des commandes au TeraRanger Evo Mini, suivez les étapes décrites dans le                           
tableau 14. 
 

Tableau 14 - Protocole d’écriture I2C 

Étape  Action  Description 

1  Envoi de 
l’adresse 

Envoyez l’octet d’adresse composé de 7 bit de l’adresse                 
de base et du dernier bit d’écriture (‘0’). 
 
exemple: 0x62 pour l’adresse de base 0x31 
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2  Envoi de la 
commande 

Envoyez la commande désirée parmi celles listées dans               
le tableau 15. 

3  Lire la réponse  Dans les cas où la commande envoyée génère une                 
réponse, lisez la réponse immédiatement. 

 
Quatre commandes sont à la disposition de l’utilisateur pour réaliser des opérations de                         
base avec le capteur. Les quatre commandes, qui sont exclusivement des commandes                       
d’écriture, sont listées dans le tableau 15. Pour obtenir une réponse d’une opération                         
d’écriture, l’utilisateur doit envoyer une commande de lecture. Pour plus de détails                       
concernant le protocole de lecture, référez-vous à la prochaine sous-section. 
 

Tableau 15 - Liste des commandes I2C du TeraRanger Evo Mini 

Commande 
(HEX) 

Nom de la 
commande  

  Description de la commande 

0x00  TRIGGER READING   Ecrivez cette commande au TeraRanger Evo Mini, et 
après 0.5 millisecondes, lisez trois octets du capteur. 
 
Les deux premiers octets reçu correspondent à un 
message de 16 bits contenant la dernière mesure en 
mm, et le troisième octet est l’empreinte CRC8. 

0x01  WHO_AM_I Ecrivez cette commande au TeraRanger Evo Mini et 
le capteur répond 0xa1. 
 
Cette fonction permet d’identifier de manière unique 
un TeraRanger Evo Mini sur le bus I2C. 

0x02  0x0W  CHANGE_MODE Ecrivez cette commande au TeraRanger Evo Mini 
pour changer de mode de mesure: 
 
La valeur W dépend du mode: 
 
W= 1 : MODE COURTE PORTEE 
W= 3 : MODE LONGUE PORTEE  

0xA2 CHANGE_BASE_AD
DR 

Ecrivez cette commande suivie de la nouvelle 
adresse de base à affecter au TeraRanger Evo Mini.  
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6.1.2. Protocole de lecture 

Pour lire une information du TeraRanger Evo Mini, suivez le protocole de lecture décrit dans le                
tableau 16. 
 

Tableau 16 - Protocole de lecture  I2C 

Étape  Action  Description 

1  Envoi de 
l’adresse 

Envoyez l’octet d’adresse comprenant les 7 bits de        
l’adresse de base suivi du bit de lecture ‘1’ 
 
exemple: 0x63 pour l’adresse de base 0x31 

2  Lecture  Lisez le nombre d’octets imposés par la commande. 
 
exemple: trois octets pour une lire une mesure en mode 1px 

 

6.2. Cas d’erreurs I2C 
 

Tableau 17 - Messages d’erreur en I2C 

Cas d’erreurs  BINAIRE  TEXTE  

Détection en-dessous de la portée minimale  0X0000  -Inf\n 

Détection au-delà de la portée maximale  0XFFFF  +Inf\n 

Mesure invalide: 
- Lumière ambiante trop élevée 
- Surface cible trop réflective 

0x0001  -1\n 
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7. Applications avec plusieurs capteurs 
La TeraRanger Evo Mini est compatible avec la carte TeraRanger Evo Hub destinée aux                           
applications avec plusieurs capteurs. Disponible en kits de 4 ou 8 Evo Mini, bénéficiez d’une                             
solution prête à l’emploi pour construire vos barres de capteurs et répondre à vos besoins                             
spécifiques! Les kits comprennent le Hub central qui intègre la technologie d’anti-crosstalk                       
pour une application multi-capteurs efficace, et renvoie les données de mesure de tous les                           
capteurs à travers une unique interface UART ou USB.  
 
Pour plus d’informations vis-à-vis des Evo Mini Array Kits, rendez-vous sur le site internet                           
de Terabee. 
 

 
La carte TeraRanger Evo Hub supporte uniquement l’utilisation du Evo Mini en                       
mode d’acquisition 1px et en mode de mesure longue portée. 

 

 
Figure 16 - Quatre TeraRanger Evo Mini sensors connectés au Hub Evo  
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8. Caractéristiques optiques 
 

8.1. Zone de réception projetée 
 
Le TeraRanger Evo Mini est capteur de mesure optique, qui se base sur le principe de                               
temps de vol infrarouge. Le capteur possède un champ de vision de 27°, ce qui correspond                               
à une surface de détection de 48 cm x 48 cm (surface de réception projetée) à 1 m de                                     
distance. La figure 17 montre l’illumination du capteur et sa géométrie à différentes                         
distances, quand le capteur est utilisé en mode 1px. 
 

 
Figure 17 - Zone de réception projetée pour le mode 1px. 
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